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Maxcast Overview 
Generally speaking Maxcast provides the easiest way to upload, organize, preserve and 

share personal or professional videos. Maxcast is a companion to Photomax and both 

applications combined provide the only 1 stop shop storage, preservation and storage 

solution for both still digital images and video.  

What Makes Maxcast Unique  

Broadcast, Without Buffering Any Length Uncompressed Video 

Maxcast is the only application that provides the capability for uploading and 

broadcasting any size uncompressed video and able to do so without any buffering. This 

means that regardless is your video is 2 minutes, or 2 hours that once it starts to play it 

will continue to do so without any need to pause in the middle of playback. This means 

that Maxcast provides the highest quality viewing experience for you family, friends, 

customers and prospects.  

Lifetime Secure Storage Guarantee” 

Any video uploaded to Maxcast, or any photo uploaded to Photomax carry a guarantee of 

lifetime storage. This means that once you upload a photo or video that you no longer 

need be concerned about losing your memories, or your content to a natural, or technical 

disaster. This means that personal videos can be passed down from generation to 

generation and family history preserved.  

Pay-Per View 

Though not released as of yet, Maxcast will be the first video platform to include a Pay-

Per View module. This means that anyone can setup their own ‘experts’ broadcast 

business and provide valuable content to a population that has an insatiable thirst for 

information. Exact release date for on board Pay-Per View is not known, it is known that 

this feature is under development and is planned to be released in the next 45 to 60 days.  

 

Also under development is the ability to have a theatre mode of display where the 

browser is completely eliminated and the ability to customize your Maxcast website.  



Business Opportunity 
Maxcast offers people interested in starting a business the opportunity to earn an income 

marketing Maxcast. If you are interested in learning more about this just reply 

mystic@intentionalmagic.com.  

Managing Photos & Videos Using Maxcast & Photomax 

Maxcast 

Logging In to Maxcast 
All Maxcast customers and users manage videos from a secure website. You can access 

your Maxcast account by going to www.maxcast.com. When you are first provided an 

account you will receive a confirmation message from Photomax containing your login 

information. As well you may have received a message from whoever set your account 

up for you. To login in to your Maxcast account just provide your email address, which is 

your username and the password you were provided. We’ll show you how to change your 

password later.  

 
Once you login to Maxcast you’ll notice that there are 5 tabs across the top. By default 

when you login you come to the “Home” tab. As well there is a tab called “Add” for 

downloading and installing the uploader which allows you to add videos, the “Manage” 

for managing your videos, the “View” tab that allows you to view the videos in a channel 

and the “Share” tab for sharing videos with friends, family, or business associates. 

Maxcast works on the basis of minutes and channels. All accounts start off as “Free” trial 

accounts that provide 60 broadcast minutes, 1 broadcast channel and 5 gb of secure 

storage that can be used to store video, or digital photo content.  

Key Terms and Concepts and Other Information 
 Minutes: Otherwise known as or referred to as “Broadcast Minutes” Lets say you 

record a 10 minute video and you share that video with 2 people. After both people 

have watched your 10 minute video the number of available minutes is reduced by 20 

– 10 minute video*2 viewings. Minutes are purchased from the “Manage” tab once 

you login.  

mailto:mystic@intentionalmagic.com
http://www.maxcast.com/


 Channels: In order for a video to be shared or for it to be played in a web page it 

must first be assigned to a channel. A Maxcast channel resolves to an internet 

address, or URL. All channels are of the form of 

http://www.maxcast.com/yourchannelname. Channels are allotted as part of a 

Maxcast subscription.  

 Subscriptions: Maxcast subscriptions start at $9.95/month for the Maxcast Basic 

which provides 2 channels and 500 broadcast minutes and 15 total 10 GB of storage. 

There is also Maxcast Premium for $24.95/month, which provides 5 channels 1500 

broadcast minutes and 15 GB of secure storage. Minutes can be added independently 

of channels at this time but channels cannot be independently added. This may 

change in the very near future. The amount of channels and/or minutes you need is 

wholly dependent on your end use in terms of how much video you shoot and need to 

store and what you intend to do with your video and how much you anticipate sharing 

video. Different subscriptions have a direct effect on the cost of the per-minute 

broadcast rate. For example for the basic package the per-minute broadcast rate is 

about 1.9 ¢ minute. The premium package of $24.95 for 1500 minutes is 1.6 ¢ 

minute. Additional packages are 

o Maxview 3500: 3500 minutes for $49.95/month or 1.4 ¢ per minute 

o Maxview 9000: 9000 minutes for $99.95/month or 1.1 ¢ per minute 

o Maxview 24000: 24000 minutes for $199.95/month, or .083¢ minute 

 Maxcast/Photomax Technical Support: Technical support is available by calling 1-

800-487-2020. Support hours are 7:00 AM to 10:00 PM M-F and on Saturday and 

Sunday from 8:00 AM to 8:00 PM.  

http://www.maxcast.com/yourchannelname


Home 
From the home tab you have immediate access to your account summary, and reports. 

Your summary reflects the number of viewing minutes you have used out of a total 

available and provides access to reports. Reports allow you to see who has watch videos 

you’ve shared, or made available in web pages. Available reports include; Who, What, 

When and Where. As a note for the “Who” report, this only reflects viewing activity from 

people you have shared videos with from within Maxcast. The other reports will reflect 

information on viewing activity by video and channel and includes any viewing activity 

from web pages.  

 
 
 



Add 
Adding videos to your Maxcast account is done by downloading, installing and running 
the ‘uploader’ application. Click on the “Add” tab and then the “Install” button to start 
the uploader installation process.  

Installing the Uploader Program 

  



Before you can install the uploader you must accept some terms and agreements. At the 
bottom f the page click on the “Accept” button to start the uploader installation process. 

 
 
 
 
 



As soon as you click on the “Accept” button you will be presented with a “File 
Download” box where you can “Run”, “Save”, or “Cancel”. To start the uploader 
installation process click on the “Run” button. 

 
The next option confirms that you want to “Run” the application. Click on the “Run” 
button to begin the installation of the uploader.  

 



Select the installation folder. It is best to just leave it at the default location. When ready 
to install the uploader click on the “Install” button. 

 
The installation should not take more then 30 seconds or so and when it is done you will 
see where it says “Completed” at the bottom of the screen as in the example below.  

 



Uploading Videos Using the Uploader 
Start the Maxcast Video uploader by going to Start/All Programs/Maxcast, Maxcast 
Uploader. This will start the uploader and will ask you to login as shown below.  

  
To start the upload process you can either click on the “Browse” button to locate any 
video on you computer or you can also drag and drop. The video will begin to upload 
automatically. When it is done you will see a green checkmark. When you’re done you 
can close the uploader, which won’t require you to login again when you restart it or you 
can logout, which will require you to login again. 

 
 



Known Uploader Issues 
Occasionally when uploading multiple videos you might notice that the 1st video will 
partially upload, abort and then the next video start. If you notice this just allow the 2nd 
video to complete. The uploader will return to the 1st video and resume from where it left 
off. If this does not occur, login to your Maxcast account, verify that there is adequate 
storage and if there is, then call Photomax/Maxcast technical support at 1-800-487-2020.  

Manage 
From the Manage tab you can view your inventory of videos. You can view your entire 
collection, or you can view your videos by channel by simply clicking on the channel 
number next to “My Channels”.  

Assigning Videos to a Channel 
Videos are listed in the order that they are uploaded with the most recently uploaded 
video at the top. When videos are first uploaded they are not assigned a channel. Before a 
video can be shared or placed in a web page it must be assigned to a channel. To assign 
video to a channel simply click on the channel next to the video that you want it assigned 
to. It will place a checkmark in the box as shown below  

 
 
 
 



Viewing Videos in a Channel  
 

 

Clicking a channel shows all videos assigned to that channel, listed in the order of 
replay. You can change the order by using the up and down arrow buttons on the 
right. You can also use the drop down category control to filter the video list by 
categories if you have assigned videos to categories. You can also view the videos 
in the channel by clicking on any video, or on the channel name next to the 
channel number designation.  Channels can have different attributes that you 
define by clicking on the blue “Edit” button to the right of the channel.  

 
 
 

 
 



Customizing Your Channel-The Channel Editor 
From the “General” tab of the channel editor you can; 1) Change the Video Name, 2) 
Enter a description of the video. You can include a link using html and 3) Define the 
channel url.  

 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 



 
 
 
 
The other 4 tabs of the channel editor are displayed below. Key items of note include; 1) 
From the “Private” tab, define a channel as public, or private with a password, 2) From 
the “Minutes” tab you control channel viewing if your minutes have expired as well as 
set the active viewing verification limit. Active viewing verification will pauses the video 
at the interval selected in order to keep someone from browsing your channel and then 
walking away while your channel continues to play and consume your broadcast minutes. 
3) You can set the color of the player and 4) Advanced settings allow you to allow people 
to sign up for Maxcast when viewing your channel (advised if you are in the Maxcast 
business) as well as control video sharing and the way the player behaves on page load 
and after it ends.  
 

 

1 2 

 

4 
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View 
Clicking on the “View” tab allows you to view videos in channels. You can change the 
channel by selecting it from the drop down list and you can play any video in a channel 
by clicking on its title. You’ll also note that next to the channel and the videos is a little 
pencil. This pencil indicates that you can edit things such as the channel and video 
description as well as invoke the advanced video editor which will be covered later. If 
you want to share from here you can share the entire channel, or an individual video in a 
channel. Click on the “Share” tab to see how.   

 
 



Share 
When you click on the “Share” tab while viewing you get the “Share” set of controls that 
allow you to select the entire channel, the currently playing video or a clip. When you 
share a clip you have to specify the starting and ending points of the clip. From here you 
can return to the viewing panel by simply clicking on the “Red” X.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



You’ll also notice that there is a small envelope at the bottom of the player. Clicking on 
this also will bring up the “Share” controls allowing you to share the current video, 
channel or clip. 

 
 



Advanced Maxcast Topics 

Advanced Video Editing 
Notice next to each video in the list there is a blue “Edit” button. This allows you to do 
some advanced video editing right from within Maxcast.  

 

When you first click on the 
edit button you get the simple editor that allows you to define the name, description and 



category. Clicking on the “Advanced” edit button brings up the advanced editor and 
allows you to cut a clip from the video. For example; 
 
Note right under the player there are two buttons. One for setting the start time and one 
for setting the stop time-so to create a clip simply start the video and click the start and 
stop buttons where to designate the clip. Then you can preview it and when done click on 
the “Save Clip” button on the bottom right and this will place the video in your list of 
videos at the top, where you can then assign it to a channel.  

 
 



Embedding a Video in Your Web Site 
You can embed the Maxcast player for an entire channel into a web page or an individual 
video.  

1. First click on the Manage tab and return to the Manage section of Maxcast.  
2. Select a channel. In the example I clicked on Channel Two.  
3. Thirdly click on the (circled) doggie paw. Once you click here it will open a new 

page.  

 
 
 
 
 
 
 
 
 
 
 



There are a number of video embedding options to choose from.  
1. Channel Page URL is code that creates a link to your channel in Maxcast. When 

clicked will take visitors to the Maxcast website and play all videos residing 
within that channel.  

2. Channel Embed Code is code that embeds the player in your web page or blog 
and plays all videos assigned to that channel.  

3. Video Page URL is code that creates a link in your web page to a specific video in 
that channel and plays the video in the Maxcast website.  

4. Video Embed Code is code that embeds the player in your website or blog and 
plays just that video.  

5. Video Preview Link is code that will provide a link to your video played back in 
Maxcast as a sample clip.  

6. Video Embed Preview is code that embeds the player for the clip in your website 
or blog.  

For any option you choose, you only need click on the blue copy button to copy the 
code to your clip board. Then just paste the code into your website. For Firefox this 
blue button may not be visible in which case you have to select the code and copy it 
manually using CTRL C.  

 
 
Then you just paste the code in your web page.  
 
Note that Maxcast is known to be compatible with Word Press and Blogger but not 
MySpace because MySpace does not currently support the iframe, html tag.  
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